
Microsoft Access 97 Keyboard Shortcuts
RIGHT ARROW in Datasheet view and Move Mode, move the selected column to the right one column. 

CTRL+TAB or CTRL+Shift+TAB Select the next or previous toolbar. 

ALT+ number (where hitting key for 1

selects the leftmost option, 2 the next,

and so on)

Select an option in the Open or Save As dialog boxes (in File menu); works within windows and dialog

boxes. 

ALT+0(ZERO) Select the folder list in the Open and Save As dialog boxes (in File menu); use within a dialog box; use

arrow keys to select a folder in the list. 

ALT+B Display the previous tip; use with Office Assistant. 

ALT+F5 Toggle between breaking and not breaking on unhandled errors and then step to the next statement. 

ALT F6; repeat until the balloon is active Activate Office Assistant while working in a document in Microsoft Access. 

ALT+F8 Toggle between breaking and not breaking in class modules and then continue execution. 

ALT+N Display the next tip when working with Office Assistant. 

CTRL+Shift+F2 Return to the last line position in the previously viewed procedure when working in View Visual Basic

code. 

CTRL+Shift+F8 Exit a procedure while working in Visual Basic code. 

CTRL Shift F9 Clear all breakpoints when working in Visual Basic code in Microsoft Access. 

CTRL+Shift+I Display parameter information on a selection when working in Visual Basic code. 

CTRL+Shift+J List all constants when viewing Visual Basic code. 

CTRL+SPACEBAR Complete the Visual Basic keyword. 

CTRL+UP ARROW Display the previous procedure when working in Visual Basic code. 

CTRL+Y Copy and remove the selected item(s) from their original location to the Clipboard. (You also can

choose the Cut command from the Edit menu.). 

CTRL-ENTER or TAB Enter a selected item into a list when working with Visual Basic code. 

ENTER Enter the selected item and move the cursor to the next line when viewing Visual Basic code. 

ESC Turn off Move mode when working in Microsoft Access Datasheet view. 

ESC Make a list disappear when working in Visual Basic code. 

F1 Display context-sensitive Help about selected keyword when viewing Visual Basic Code. 

F2 Display the Object Browser when working with Visual Basic code. 

F3 Find the next occurrence of the text specified in the Find or Replace dialog box when the dialog box is

closed when editing Visual Basic code. 

F5 Run a parameterless subprocedure containing the insertion point, from the Module window when

working with Visual Basic code. 

F5 Continue execution of code or macro when working with Visual Basic code. 

F6 Cycle through all the panes in the active window when working in Form view. 

F6 Move between the upper and lower portions of a window when working with Visual Basic code. 

F8 Step into a procedure (single step) when working with Visual Basic code in Microsoft Access. 

F9 Toggle a breakpoint at the selected line when working with Visual Basic code. 

LEFT ARROW Select the column to the left, of the current column, if the current column is selected. 

LEFT ARROW Move the selected column to the left one column in Move mode. 

RIGHT ARROW in Datasheet view, select the column to the right, if the current column is selected. 

Shift+F2 View a procedure definition, variable, or keyword when working with Visual Basic code. 

Shift+F3 In Visual Basic code, find the previous occurrence of the text specified in the Find or Replace dialog

box when the dialog box is closed. 

Shift+F5 Reset the execution of a code or macro when working with Visual Basic code. 

Shift F6 Cycle back through sections when navigating in Form view in Microsoft Access. 

Shift+F8 Step over a procedure when working with Visual Basic code. 

Shift+F9 Create an instant watch for a selected expression when working with Visual Basic code. 

Shift+TAB or CTRL+Shift+M Remove indentation from selected lines when working in Visual Basic code. 

TAB or CTRL+M Indent selected lines when working with Visual Basic code. 

ALT Close the visible menu and submenu at the same time; works with menu commands. 
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ALT+ letter key, where key is the

underlined letter in the field or menu

cmnd

Select a menu or select or clear the check box by the letter underlined in the menu command; works

within windows and dialog boxes. 

CTRL+Shift+RIGHT ARROW Select or unselect one word to the right of the cursor. 

CTRL Shift TAB Exit the subform and move to the previous field in the main form or previous record in Microsoft

Access. 

CTRL+Shift+TAB or CTRL+PAGE UP Go to the previous tab when working in a tabbed dialog box. 

ALT+DOWN ARROW Display more Help topics; works when using Office Assistant. 

ALT+DOWN ARROW Open a selected drop-down menu; works within a dialog box. 

ALT+ENTER Display the properties of a selected item while working in a window. 

ALT+F4 Quit Microsoft Access, close a dialog box, or close a property sheet; works within an open window. 

ALT+number (where hitting key for 1

selects the leftmost option, 2 the next,

and so on)

Select a Help topic while using Office Assistant. 

ALT+Shift+TAB Move from active application window to previously active application window. 

ALT+SPACEBAR Open the menu of the leftmost icon on the main toolbar bar of the active window; this menu typically

contains the following commands: Restore, Move, Size, Minimize, Maximize and Close. 

ALT SPACEBAR Display the Control menu while working from Help menu in Microsoft Access. 

ALT+TAB Move from active application window to the previously used application window; to select an

application from a list of the open applications, hold ALT down and press TAB more than once to move

through the list. 

ALT+UP ARROW Display previously viewed Help topics while using Office Assistant. 

ARROW KEY Move between options in a selected drop-down menu or dialog box or between some options in a

group of options. 

ARROW KEY Move between options in a selected drop-down menu or dialog box or between some options in a

group of options; add ENTER to select an option. 

BACKSPACE Delete selected text or to delete the character to the left of where the cursor is positioned within a

document while editing. 

C or ESC Cancel Print Preview or Layout Preview and return to Normal view. 

CTRL+A or CTRL+Shift+SPACEBAR Select all records in an active database. 

CTRL+ALT+SPACEBAR Insert the default value for a selected field when entering data in a Datasheet or Form view. 

CTRL+APOSTROPHE (') Insert the value from the same field in the previous record to the selected field in the current record

within a database. 

CTRL+C Copy selection to the Windows Clipboard. 

CTRL+COLON (:) Insert the current time at the cursor's current position. 

CTRL+DOWN ARROW Move to the same field in the last record while in Navigation mode in Datasheet view. 

CTRL+DOWN ARROW Move to the bottom of current page in which you are working while in Print Preview and Layout

Preview. 

CTRL END Move to the end of the active field, while working working with multiple-line fields in Microsoft Access. 

CTRL END Move to the last field in the last record while in Navigation mode in Microsoft Access. 

CTRL+END To move to the last field in the last record while in Navigation mode and Form view in Access. 

CTRL+END Move to the lower-right corner of the page while working in Print Preview and Layout Preview. 

CTRL ENTER Insert a new line when entering data in Datasheet or Form view in Microsoft Access. 

CTRL+ENTER or ALT+D To open the selected table, query, form, report, macro, or module while working in Design view in

Access. 

CTRL+ESC Display Windows Start menu. 

CTRL+F Display the Find dialog box while working in Access Datasheet view, Form view or Module Window

only. 

CTRL+F11 Toggle between a custom menu bar and a built-in menu bar while working in Access. 

CTRL F2 Invoke a Builder while working in Microsoft Access. 

CTRL+F6 Go to the next database window in the active application. 
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CTRL+F6 Move between open windows. 

CTRL+H To open the Replace dialog box (while in Datasheet view, Form view, and Module Window only). 

CTRL HOME Go to the beginning of the field, in multiple-line fields, when working in Microsoft Access. 

CTRL+HOME Go to the first field in the first record when working in Navigation mode in Datasheet view. 

CTRL+HOME Go to the first field in the first record when working in Navigation mode in Form view. 

CTRL+HOME Go to the upper-left corner of the page when in Print Preview and layout Preview mode. 

CTRL LEFT ARROW Move cursor's position one word to the left in Microsoft Access. 

CTRL+LEFT ARROW or CTRL+RIGHT

ARROW

Move cursor's position one word to the left or right. 

CTRL+MINUS SIGN (-) Delete the current record when working in Datasheet or Form view. 

CTRL+N Open a new, blank, database. 

CTRL+O Display the Open dialog box in order to find and open an existing database. 

CTRL+P Display the Print dialog box in order to print the active selection. 

CTRL PAGE DOWN Go right one screen in Microsoft Access. 

CTRL+PAGE DOWN Go to the same field in the next record. 

CTRL+PAGE UP Go left one screen when working in datasheet view in Access. 

CTRL+PAGE UP Go to the same field in the previous record. 

CTRL+PLUS SIGN (+) Add a new record while working in Datasheet or Form view in Access. 

CTRL+RIGHT ARROW Move cursor one word to the right. 

CTRL+S or Shift+F12 or ALT+Shift+F2 Save a database object. 

CTRL SEMICOLON (;) Insert the current date into active Datasheet or Form view in Microsoft Access. 

CTRL+Shift+F6 Go to the previous database window. 

CTRL+Shift+LEFT ARROW Select or unselect one word to the left of the cursor. 

CTRL+Shift+LEFT ARROW To extend selection one word to the left. 

CTRL+SPACEBAR Select or unselect the active column, in Navigation mode only. 

CTRL+TAB Move through the tabs of each object's type when navigating and opening objects in Access. 

CTRL+TAB Exit the subform and move to the next field in the master form or next record when working in Form

view. 

CTRL TAB or CTRL PAGE DOWN Move to the next tab on a tabbed dialog box in Microsoft Access. 

CTRL+UP ARROW Move to the current field in the first record, in Navigation mode. 

CTRL+UP ARROW Move to the top of the active page when working in Access Print Preview and Layout Preview mode. 

CTRL+V Paste a copied item(s) from the Clipboard into a selected location (You also can choose Paste from

the Edit menu.). 

CTRL+W or CTRL+F4 Close the active datasheet window. 

CTRL+X Copy and remove the selected item(s) from their original location to the Clipboard. (You also can

choose the Cut command from the Edit menu.). 

CTRL+Z or ALT+BACKSPACE Undo the last action; note: some actions, like Shutdown, cannot be undone (You also can choose

Undo from the Edit menu.). 

DELETE Delete the selected item(s), or to delete the character to the right of the cursor; if items are files they

will be moved to the Recycle Bin. 

DOWN ARROW To move down one line in a Combo box, list box or Database window in Microsoft Access. 

DOWN ARROW Move to the same field in the next record when navigating in Access Datasheet view. 

DOWN ARROW Scroll down a window or document in small increments when working in Access Print Preview or

Layout Preview. 

DOWN ARROW or UP ARROW (with the

menu or submenu displayed)

Select the next or previous command on the menu or submenu. 

END Go to the end of the entry when editing a text box. 

END Go to the last object in database window in Microsoft Access. 

END Go to the end of the field, in single-line fields. 

END Go to the last field in the current record, when working in Access Navigation mode. 
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END OR CTRL+RIGHT ARROW Move to the right edge of the page when working in Access Print Preview and Layout Preview. 

ENTER Perform the action assigned to the selected default button in a dialog box in Microsoft Access. 

ENTER Restore a selected minimized program window when all windows are minimized. 

ENTER Open the selected table or query in Datasheet view, or form in Form view. 

ENTER Open the selected report in Print Preview. 

ENTER Run a selected macro in Microsoft Access. 

ENTER Perform the action assigned to a selected button on a toolbar. 

ENTER Open a selected menu on a toolbar. 

ENTER Enter text in a selected text box. 

ESC Close the visible menu; or, with a submenu visible, close the submenu only. 

ESC Cancel a command and close the dialog box. 

ESC Close an Office Assistant message or tip. 

ESC Cancel Extend mode command in Microsoft Access. 

ESC Undo changes in the current field or current record; if both have been changed, press ESC twice to

undo changes first in the current field and then in the current record. 

ESC (when a drop-down list box is

selected)

Close a selected drop-down list in a dialog box. 

F1 Display Help or the Office Assistant. 

F1 Display the Office Assistant or Microsoft Access Contents and Index; context-sensitive help about the

selected property, control, macro action, or Visual Basic keyword; or alerts with a Help button. 

F10 Activate, or select, the main toolbar beginning with the first toolbar option on the left, usually File; after

the first option is activated you can navigate through toolbar and menu options using the appropriate

ARROW keys; press F10 or ALT again 

F11 or ALT+F1 Bring the Database window to the front. 

F12 or ALT F2 Display Save As dialog box (file menu) in Microsoft Access. 

F2 Display the complete hyperlink address for a selected hyperlink. 

F2 Rename a selected object when working in Database window. 

F2 Move between Edit mode (with insertion point displayed) and Navigation mode when working in

Design view. 

F4 or ALT DOWN ARROW Open a combo box in Microsoft Access. 

F5 Update the files visible in the Open or Save As dialog box (File menu). 

F5 Move to Form view from Form design or a Form module when working in Access Design view. 

F5 Navigate through records by moving cursor to the record number box, typing the record number and

pressing ENTER when working in Datasheet view. 

F5 Navigate through records by moving cursor to the record number box, typing the record number and

pressing ENTER when working in Form view. 

F5 Navigate through pages by moving cursor to the page number box, typing the page number and

pressing ENTER when working in Print Preview and Layout. 

F6 Move between the upper and lower portions of a window when working in Design view of tables,

macros, and queries and the Advanced Filter/Sort window only. 

F7 Display Spelling and Grammar dialog box (Tools Menu) in Microsoft Access. 

F8 Activate Extend mode; EXT appears in the lower right corner of the window; pressing F8 repeatedly

extends the selection to the word, the field, the record (in Datasheet view only), and all records; press

ESC to cancel. 

F9 Refresh the contents of a Lookup field list box or combo box. 

F9 Recalculate the fields in the window. 

HOME Go to the beginning of the current entry. 

HOME Go to the first object. 

HOME Go to the beginning of the current field, in single-line fields. 

HOME Go to the first field in the current record, when in Access Navigation mode. 

HOME or CTRL LEFT ARROW Go to the left edge of the current page in Microsoft Access. 
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HOME or END Select the first or last command on the menu or submenu. 

LEFT ARROW Go one character to the left of the cursor's current position in the field. 

LEFT ARROW Scroll to the left of the cursor's current position in small increments when working in Print Preview and

Layout Preview. 

LEFT ARROW or RIGHT ARROW With a menu open, select the menu to the left or right of the original, or, with a submenu visible, switch

between the main menu and the submenu. 

LEFT ARROW or RIGHT ARROW Move one character to the left or right in a text box. 

LEFT ARROW, or RIGHT ARROW Extend a selection to adjacent fields in the same row in Microsoft Access Datasheet view. 

Letter key, where the letter is the same

as the first letter in optn you want on a

selected menu

Choose a selected menu, drop-down list, or dialog box option by typing the first letter in the option

name. 

P or CTRL+P To open the Print dialog box from Print Preview or Layout Preview. 

PAGE DOWN Move down one page when using a Combo box or list box. 

PAGE DOWN Move down one window when working in Database view in Microsoft Access. 

PAGE DOWN Scroll down one full screen when working in Print Preview and Layout Preview. 

PAGE DOWN When navigating in Form view, go down one page; at the end of the record, moves to the equivalent

page on the next record. 

PAGE DOWN or DOWN ARROW In Print Preview and Layout Preview, view the next page (when Fit To Window is selected). 

PAGE UP Move up one page when using a combo box or list box. 

PAGE UP Move up one window when working in Database. 

PAGE UP Go up one screen when working in Datasheet view in Microsoft Access. 

PAGE UP Go up one page when working in Form view; at the end of the record, use to move to the equivalent

page on the previous record. 

PAGE UP Scroll up one full screen when working in Print Preview and Layout Preview. 

PAGE UP or UP ARROW In Print Preview and Layout Preview, view the previous page (when Fit To Window is selected). 

RIGHT ARROW Move one character to the right of the cursor's current position in a field. 

RIGHT ARROW In Print Preview and Layout Preview, scroll to the right in small increments. 

S In Print Preview and Layout Preview, open the Page Setup dialog box. 

Shift+CTRL+TAB Cycle through the tab of each object's type moving right to left. 

Shift DOWN ARROW Extend selection to the next record, if the current record is selected in Microsoft Access. 

Shift+END Select from the insertion point to the end of the text box entry. 

Shift+ENTER Add a control to a section when working in Form and Report Design view only. 

Shift+ENTER Save changes to the current record when entering data in the Datasheet or Form view. 

Shift+F1 Display What's This? help; after pressing SHFT+F1, move the pointer to the menu command, toolbar

button, dialog box option, or screen region to see definitions. 

Shift F10 Display a shortcut menu that shows a list of commands relevant to the selected object in Microsoft

Access. 

Shift+F2 Open the Zoom box to conveniently enter expressions and other text in small input areas. 

Shift+F4 Find the previous occurrence of the text specified in the Find or Replace dialog box when the dialog

box is closed. 

Shift+F8 Undo a previous selection extension. 

Shift+F9 Requery the underlying tables; in a subform, this requeries the underlying table for the subform only. 

Shift+HOME Select from the insertion point in the text box to the beginning of the text box entry. 

Shift LEFT ARROW Select or unselect one character to the left of the cursor's position in Microsoft Access. 

Shift+RIGHT ARROW Select or unselect by one character to the right of the cursor's current position. 

Shift+SPACEBAR Switch between selecting the current record and the first field of the current record, when working in

Navigation mode. 

Shift+TAB Move to the previous option or option group in a dialog box. 

Shift TAB Move to the previous field when navigating in Form view in Microsoft Access. 

Shift+TAB Enter the subform from the following field in the main form when navigating in Form view. 
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Shift+TAB, or LEFT ARROW Move to the previous field when navigating in Datasheet view. 

Shift+UP ARROW Extend selection to the previous record, if the current record is selected. 

SPACEBAR Perform the action assigned to the active button, or select or clear the active check box in the dialog

box. 

SPACEBAR Switch between the values in a check box or option button. 

TAB Move to the next option or option group in a dialog box in Microsoft Access. 

TAB Exit the combo box or list box. 

TAB Select the next field. 

TAB Move to the next field when working in Form view. 

TAB To enter the subform from the preceding field in the main form when working in Form view in Microsoft

Access. 

TAB or Shift+TAB (when a toolbar is

active)

When a toolbar is active, select the next or previous button or menu on the toolbar. 

TAB, ENTER, or RIGHT ARROW Move to the next field when navigating in Datasheet view. 

UP ARROW Move up one line in a combo box or list box. 

UP ARROW Move up one line in a database window in Microsoft Access. 

UP ARROW Move to the current field in the previous record when navigating in Datasheet view. 

UP ARROW Scroll up in small increments when working in Print Preview and Layout Preview. 

UP ARROW, DOWN ARROW Extend a selection to adjacent rows in Datasheet view. 

Z Zoom in or out on a part of the page when working in Print Preview and Layout Preview. 

CTRL+A So select all visible code in the Module window when editing with Visual Basic code. 

CTRL+BREAK Halt the execution of code or a macro requested when running or debugging Visual Basic code. 

CTRL DOWN ARROW Display the next procedure while viewing Visual Basic code in Microsoft Access. 

CTRL+F2 Put focus on the Object Box while working in Visual Basic code view. 

CTRL+F2 (then press TAB) Put focus on the Procedure Box while working in Visual Basic code view. 

CTRL+F3 Find the next occurrence of selected text while working in Visual Basic code view. 

CTRL+F8 Activate Move mode for active window (MOV appears in the lower right corner of the window) while in

Datasheet view. 

CTRL+F8 Run Visual Basic code to the cursor's current point and halt execution. 

CTRL F9 Set the next statement while working with Visual Basic code in Microsoft Access. 

CTRL+G To display the Debug dialog box while working with Visual Basic code. 

CTRL+I To display Quick Information when working in Visual Basic code. 

CTRL+J List Properties and Methods when working in Visual Basic code. 

CTRL L Display the Calls dialog box when working in Visual Basic code in Microsoft Access. 

CTRL+R Select a form or report.  

Visit http://www.shortcutmania.com/ for more printable keyboard shortcuts


